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Introduction and Overview

This manual is intended to help any user to perform a VBM analysis using the VBMS8 Toolbox. It covers
different aspects of this type of analysis — starting with the very basics and ending up with additional

information on how to deal with different data. Basically it may be divided into four main sections:

® Naturally, a quick guide of how to get started is given at the beginning. This section provides
information how to download and install the software and start the Toolbox. Furthermore, a short

overview on the steps of a VBM analysis is given.

® A detailed description of a basic VBM analysis is subsequently given, which will guide the user step
by step through the whole process — from preprocessing to the selection of contrasts. This

description should provide all necessary information to analyze most studies successfully.

®* There are a few special cases of VBM analyses, for which the basic analysis workflow has to be
adapted. These cases are longitudinal studies and studies in children or special patient populations.
Relevant changes to a basic VBM analysis are described here and a description of how to apply
these changes is provided. Importantly, only the changes are described — steps like for example

quality control or smoothing are the same as in the basic analysis and not described a second time.

®* The manual closes with information on native, normalized and modulated volumes, which
determines how the results may be interpreted. Furthermore an overview of the naming

conventions used as well as technical information is given.



Getting Started
DOWNLOAD AND INSTALLATION

The VBMS8 Toolbox runs within SPM8. That is, SPM8 needs to be installed and added to your
Matlab  search  path  before the VBM8 Toolbox can be installed (see
http://www.fil.ion.ucl.ac.uk/spm/ and http://en.wikibooks.org/wiki/SPM).

Download (http://dbm.neuro.uni-jena.de/vbm8/) and unzip the VBMS8 Toolbox. You will get a
folder named “vbm8”, which contains various matlab files and compiled scripts. Copy the folder
“vbm8” into the SPM8 “toolbox” folder.

STARTING THE TOOLBOX

Start Matlab
Start SPM8 (i.e., type “spm fmri”)

Select “vbm8” from the SPM menu (see Figure 1). You will find the drop-down menu between the
“Display” and the “Help” button. This will open the VBMS8 Toolbox (in SPM’s 2nd window). You
can access the VBMS8 Toolbox menu by clicking on “VBM8” (located at the upper left corner of
this window; see Figure 2).
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Figure 1: SPM menu Figure 2: SPM’s 2" window with the VBMS
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BASIC VBM ANALYSIS (OVERVIEW)
The VBMS8 Toolbox comes with different modules, which may be used for an analysis. Usually, a VBM
analysis comprises the following steps:

(a) Preprocessing:

1.

T1 images are normalized to a template space and segmented into gray matter (GM), white
matter (WM) and cerebrospinal fluid (CSF). The preprocessing parameters can be adjusted via
the module “Estimate and write”.

After the preprocessing is finished, a quality check is highly recommended. This can be
achieved via the modules “Display one slice for all images” and “Check sample homogeneity
using covariance”. Both options are located under “VBM8 > Check data quality”.

Before entering the GM images into a statistical model, image data need to be smoothed. Of
note, this step is not implemented into the VBMS8 Toolbox but achieved via the standard SPM
module “Smooth”.

(b) Statistical analysis:

4.

The smoothed GM images are entered into a statistical analysis. This requires building a
statistical model (e.g., T-Tests, ANOVAs, multiple regressions). This is done by the standard
SPM modules “Specify 2nd Level”.

The statistical model is estimated. This is done by the standard SPM module “Estimate”.

After estimating the statistical model, contrasts will be defined to get the results of the
analysis. This is done by the standard SPM module “Results”.

The sequence of “preprocessing = quality check = smoothing = statistical analysis” remains the
same for every VBM analysis, even when different steps are adapted (see “special cases”).



A few words about the Batch Editor...

As soon as you select a module from the VBM8 Toolbox menu, a new window (the Batch
Editor) will open. The Batch Editor is the environment where you will set up your analysis (see
Figure 3). For example, an “<-X" indicates where you need to select files (e.g., your image files,
the template, etc.). Other parameters have either default settings (which can be modified) or
require input (e.g., choosing between different options, providing text or numeric values, etc.).

Once all missing parameters are set, a green arrow will appear on the top of the window (the
current snapshots in Figure 3 show the arrow still in gray). Click this arrow to run the module
or select “File = Run Batch”. It is very useful to save the settings before you run the batch
(click on the disk symbol or select “File = Save Batch”).

Of note, you can always find helpful information and parameter-specific explanations at the
bottom of the Batch Editor window."

All settings can be saved either as .mat file or as .m script file and reloaded for later use. The
.m script file has the advantage to be editable with a text editor.
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Figure 3: The Batch Editor is the environment where the analysis is set up. Left: For all settings
marked with “<-X”, files have to be selected (“Select Files”). Right: Parameters can be edited and
adapted (“Edit Value”).

! Additional VBMS8-related information can be found by selecting “VBM Tools website” in the VBMS8 Toolbox menu. This
will open a website. Here, look for “VBM subpages” on the right.

Of note, for debugging, the relevant information can be printed by selecting “Print VBM debug information” from the
VBMS8 Toolbox menu.



Basic VBM analysis (detailed description)
1. Select your working directory.

Before running anything, it is recommended to always set SPM’s working directory:
“Utilities = CD” (right to the “Help” button in the SPM main menu). Select your working
directory and click “Done” to change the directory.

Open the VBM Toolbox.
Select the module you want to run.

Specify the parameters (see below).

LA S S

Run the module.

Modules

FIRST MODULE: ESTIMATE AND WRITE

VBMS8 = Estimate and write
Parameters:

o Volumes <-X = Select Files = [select raw data] = Done

- Select one volume for each subject. As the Toolbox does not support multispectral
data yet (i.e., different imaging methods for the same brain, such as T1-, T2-,
diffusion-weighted or CT images), it is recommended to choose a T1l-weighted
image.

- Importantly, the images need to be in the same orientation as the template and
priors; you can double-check and correct via using “Display” in the SPM menu. By
default the MNI template is used (located in your SPM folder “spm8 > templates
-2 T1”)

o Estimation Options = [use defaults or modify]

- The defaults provide a solid starting point for the analysis. If you prefer to use
your own customized Tissue Probability Maps (TPMs), you can specify / select
them here. However, the new segmentation approach in VBM8 does not
need tissue priors for the segmentation anymore. Customized TPMs will be
only used for the spatial normalization. Thus, creating your own TPMs might
be only appropriate for children’s data if they largely deviate from the



standard MNI template. In order to create your own TPMs the Template-O-
Matic (TOMS8) Toolbox can be used.

o Extended Options = [use defaults or modify]

Again, the defaults provide a solid starting point. The high-dimensional
DARTEL normalization is used as the default spatial normalization.
Alternatively, the low-dimensional SPM8 spatial normalization can be chosen.
Furthermore, remaining non-brain tissue can be removed more thoroughly by
setting the option “Clean up any partitions” to “Thorough Cleanup”. This is
particularly useful for very atrophic brains (e.g., as occurring in Alzheimer’s
disease). The parameters for two de-nosing methods can be also changed.
The optimal weighting for the SANLM filter is internally estimated. The MRF
weighting is not necessary to change, because the SANLM filter will have a
much larger de-nosing effect. Values of “0” will deselect both filters.

o Writing Options = [use defaults or modify]

For GM, WM, and CSF image volumes see page 14: “Additional Information
on native, normalized and modulated normalized volumes”. Note: The default
option “Modulated normalized — non linear only” will result in an analysis of
relative differences in regional GM volume, corrected for individual brain size.

A bias corrected image volume, in which MRI inhomogeneities and noise are
removed, can be written in normalized or native space. This is useful for
quality control and also to create an average image of all normalized T1
images in order to display / overlay the results. Note: For a basic VBM analysis
use the defaults.

A partial volume effect (PVE) label image volume can also be written in
normalized or native space or as a DARTEL export file. This is useful for quality
control and also for future applications using this image to reconstruct
surfaces. Note: For a basic VBM analysis use the defaults.

The Jacobian determinant for each voxel can be written in normalized space.
This information can be used to do a Tensor-Based Morphometry (TBM)
analysis. Note: For a basic VBM analysis this is not needed.

Finally, deformation fields can be written. This option is useful to re-apply
normalization parameters to other images or particular regions of interest.
Note: For a basic VBM analysis this is not needed.

After setting all parameters, you will be able to save and run the module:

File > Save Batch [optionally save your model and selections as a *.m script file; the next time
you can simply load this *.m script file with “Load Batch”, and adjust / modify respective sections
if necessary].

File > Run Batch [the outcomes will be written to the same directory like the original data]. As
per defaults, the outcomes will be the bias corrected normalized volumes (wm*) and the tissue
segments (i.e., the modulated normalized gray matter (mOwrp1*) and white matter (mOwrp2)
segments of each volume). If you selected the low-dimensional spatial normalization approach the
modulated images will be named mOwp1* for gray matter and mOwp2* for white matter. All
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possible naming is summarized under “Naming convention of output files” (p. 17) and in the
graphics window of SPM, when the SPM8 Toolbox is started.

SECOND MODULE: DISPLAY ONE SLICE FOR ALL IMAGES

VBMS8 > Check data quality = Display one slice for all images
Parameters:
o Volumes <-X = Select Files = [select the new files] = Done

- Select the newly written data [e.g. the “wm™*” files, which are the normalized bias
corrected volumes]. This tool will display one horizontal slice for each subject, thus
giving a good overview if the segmentation and normalization procedures yielded
reasonable results. For example, if the native volume had artifacts or if the native
volumes had a wrong orientation, the results may look odd. Solutions: Use “Check
Reg” from the SPM main menu to make sure that the native images have the same
orientation like the MNI Template (“SPM - templates = T1”). Adjust if necessary
using “Display” from the SPM main menu.

o Proportional scaling = [use defaults or modify]
- Check “yes”, if you display T1 volumes.

Show slice in mm = [use defaults or modify]
- This module displays horizontal slices. This default setting provides a good

overview.

- File = Save Batch

- File = Run Batch [the outcomes will be displayed in SPM’s graphic window]

THIRD MODULE: CHECK SAMPLE HOMOGENEITY USING COVARIANCE

VBMS8 > Check data quality = Check sample homogeneity using covariance
Parameters:

o Volumes <-X = Select Files = [select gray matter volumes] - Done

- Select the newly written data [e.g. the “mOwrp1*” files, which are the normalized
(wr) GM segments (p1) modulated for the non-linear components (m0)]. This tool
visualizes the covariance between the volumes using a boxplot and covariance
matrices. Thus, it will help identifying outliers. Any outlier should be carefully



inspected for artifacts or pre-processing errors using “Check Reg” from the SPM
main menu.

o Proportional scaling = [use defaults or modify]

Check “yes”, if you display T1 volumes.

o Show slice in mm = [use defaults or modify]

“Omm” means the center slice along the origin of the MNI template.

o Nuisance = [enter nuisance variables if applicable]

- File = Save Batch
- File = Run Batch

For each nuisance variable which you want to remove from the data prior to
calculating the covariance, select “New: Nuisance” and enter a vector with
the respective variable for each subject (e.g. age in years). All variables have
to be entered in the same order as the respective volumes. You can also type
“spm_load” to upload a *txt file with the covariates in the same order as the
volumes.

A boxplot window and covariance matrices will open, which depict the
covariance between the volumes; outliers can be displayed in SPM’s graphic
window. The covariance matrix shows the covariance between all volumes.
High covariance values mean that your data are more similar. The boxplot
summarizes all covariance values for each subject and shows the
homogeneity of your sample. A small overall covariance in the boxplot not
always means that this volume is an outlier or contains an artifact. If there are
no artifacts in the image and if the image quality is reasonable you don’t have
to exclude this volume from the sample. This tool is intended to utilitize the
process of quality checking and there is no clear criteria defined to exclude a
volume only based on the overall covariance value. However, volumes with
an overall covariance below two standard deviations are indicated and should
be checked very carefully.

FOURTH MODULE: SMOOTH

SPM menu = Smooth

Parameters:

o Images to Smooth <-X = Select Files = [select grey matter volumes] > Done



- Select the newly written data [e.g. the “mOwrpl” files, which are the
normalized (wr) grey matter segments (pl) modulated for the non-linear
components (m0)].

o FWHM - [use defaults or modify]

- 8-12mm kernels are widely used for VBM. To use this setting select “edit
value” and type “8 8 8” (or “12 12 12", respectively) for a kernel with 8mm
(with 12mm) FWHM.

o Data Type = [use defaults or modify]

o Filename Prefix = [use defaults or modify]

File = Save Batch [this will save the parameters as *.m script file]

File = Run Batch [the outcomes will be written to the same directory like the original data]

Building the statistical model

Although there are many potential designs offered in the 2nd-level analysis | recommend to use the
“Full factorial” design because it covers most statistical designs. For cross-sectional VBM data you
have usually 1..n samples and optionally covariates and nuisance parameters:

Number of factor levels Number of covariates | Statistical Model

1 0 one-sample t-test
1 1 single regression
1 >1 multiple regression
2 0 two-sample t-test
>2 0 Anova
-1 0 Ancova (for nuisance parameters) or

Interaction (for covariates)
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TWO-SAMPLE T-TEST

SPM menu = Specify 2"-level
Parameters:

o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design =2 “Two-sample t-test”
» Group 1 scans > Select Files > [select the smoothed grey matter volumes for

group 1; following this script
these will be the “smOwpl” files]
- Done

= Group 2 scans > Select Files >
[select the smoothed grey matter
volumes for group 2] > Done

* |ndependence = Yes

= Variance - Equal or Unequal
= Grand mean scaling 2 No

= ANCOVA - No

. *
Covariates

You could specify one or many
covariates (i.e., partial out the
variance of specific factors when
looking at group differences)
® (Covariates 2 New Covariate
® Vector <-X = enter the values of
the covariates (e.g., age in years)
in the same order as the
respective file names or type
“spm_load” to upload a *.txt file
with the covariates in the same

o) order as the volumes
. ® Name <-X = Specify Text (e.g.,
o Masking “age”)
» Threshold Masking = Absolute ® |nteractions = None
~ [specify value (e.g., “0.17)] ® Centering = No centering
* Implicit Mask = Yes
= Explicit Mask = <None>
o Global Calculation = Omit
o Global Normalization
= Qverall grand mean scaling > No
o Normalization > None

- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]
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USING THE FULL FACTORIAL MODEL (FOR A 2X2 ANOVA)

SPM menu = Specify 2"-level

Parameters:

o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design = “Full Factorial”

Factors 2 “New: Factor; New: Factor”

Factor

- Name -2 [specify text (e.g., "sex”)]
- Levels > 2

- Independence = Yes

- Variance = Equal or Unequal

- Grand mean scaling 2 No

- ANCOVA - No

Factor

- Name -2 [specify text (e.g., “handedness”)]
- Levels > 2

- Independence = Yes

- Variance = Equal or Unequal

- Grand mean scaling 2 No

- ANCOVA - No

Specify Cells > “New: Cell; New: Cell; New: Cell; New: Cell”

Cell

- Levels = [specify text (e.g., “1 1”)]

- Scans > [select files (e.g., the smoothed GM volumes of the left-handed
males)]

Cell

- Levels = [specify text (e.g., “1 2”)]

- Scans > [select files (e.g., the smoothed GM volumes of the right-handed
males)]

Cell

- Levels = [specify text (e.g., “2 1”)]

- Scans > [select files (e.g., the smoothed GM volumes of the left-handed
females)]

Cell

- Levels = [specify text (e.g., “2 2”)]

- Scans > [select files e.g., the smoothed GM volumes of the right-handed
females)]

. *
o Covariates

o Masking

Threshold Masking = Absolute > [specify value (e.g., “0.1”)]
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* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]

MULTIPLE REGRESSION (CORRELATION)

SPM menu = Specify 2"-level
Parameters:
o Directory <-X = Select Files = [select the directory for your analysis] = Done

o Design 2 “Multiple Regression”
= Scans 2 [select files (e.g., the smoothed GM volumes of all subjects)] = Done

= Covariates = “New: Covariate”

Covariate
- Vector - [enter the values in the same order as the respective file names of
the smoothed GM images]
- Name -2 [specify test (e.g, “age”)]
- Centering = No centering
- Intercept = Include Intercept
o Covariates’
o Masking

» Threshold Masking = Absolute = [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [This will create an “SPM.mat” file in your selected folder]
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USING THE FULL FACTORIAL MODEL (FOR AN INTERACTION)

SPM menu = Specify 2"-level
Parameters:
o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design = “Full Factorial”

» Factors = “New: Factor”
Factor
- Name -2 [specify text (e.g., "sex”)]
- Levels > 2
- Independence = Yes
- Variance = Equal or Unequal
- Grand mean scaling 2 No
- ANCOVA - No

= Specify Cells 2> “New: Cell; New: Cell”
Cell
- Levels = [specify text (e.g., “1”)]
- Scans =2 [select files (e.g., the smoothed GM volumes of the males)]
Cell
- Levels = [specify text (e.g., “2”)]
- Scans =2 [select files (e.g., the smoothed GM volumes of the females)]
o Covariates 2 “New: Covariate”
= Covariate
- Vector - [enter the values in the same order as the respective file names of
the smoothed GM images]
- Name -2 [specify test (e.g, “age”)]
- Interactions = With Factor 1
- Centering = No centering
o Masking

» Threshold Masking = Absolute = [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]
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ESTIMATING THE STATISTICAL MODEL

SPM menu - Estimate
Parameters:
o Select SPM.mat <-X = Select Files = [select the SPM.mat which you just built] = Done
o Method = “Classical”

- File = Save Batch

- File = Run Batch [This will create an “SPM.mat” file in your selected folder]

DEFINING CONTRASTS

SPM menu > Results > [select the SPM.mat file] > Done (this opens the Contrast Manager) —>
Define new contrast (i.e., choose “t-contrast” or “F-contrast”; type the contrast name and specify the
contrast by typing the respective numbers, as shown below):

T-contrasts:

a. Simple group difference

= Use SPM.mat from model “2 sample T-test”
® For Group A > Group B: specify “1-1”
® For Group A < Group B: specify “1 1”7

b. 2x2 ANOVA

= Use SPM.mat from model “2x2 ANOVA”
® For left-handed males > right-handed males: specify “1 -1 0 0”
®* For left-handed females > right-handed females: specify “00 1 -1”
®* For left-handed males > left-handed females: specify “1 0-1 0”
® For right-handed males > right-handed females: specify “01 0-1”
etc.
®* For males > females: specify “11-1-1"
® For left-handers > right-handers: specify “1-11-1"
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c. Multiple Regression (Correlation)

= Use SPM.mat from model “CORRELATION”
®* For positive correlation: specify “1”
®* For negative correlation: specify “-1”

d. Interaction

= Use SPM.mat from model “INTERACTION”
® Forregression slope Group A > Group B: specify “00 1 -1”
® Forregression slope Group A < Group B: specify “00-1 1”

- Done

F-contrasts:

If you would like to use the old SPM2 F-contrast “Effects of interest” the respective contrast vector is:

eye(n)-1/n

where n is the number of columns of interest. This F-contrast is often helpful for plotting parameter
estimates of effects of interest.

Getting Results:
SPM menu - Results = [select a contrast from Contrast Manager] > Done

® Mask with other contrasts = No
® Title for comparison: [use the pre-defined name from the Contrast Manager or change it]

® Pvalue adjustment to:
o None (uncorrected for multiple comparisons), set threshold to 0.001
o FDR (false discovery rate), set threshold to 0.05, etc.
o FWE (family-wise error), set threshold to 0.05, etc.

* Extent threshold: [either use “none” or specify the number of voxels?)

% In order to empirically determine the extent threshold (rather than saying 100 voxels or 500 voxels, which is completely
arbritrary), simply run this first without specifying an extent threshold. This will give you an output (i.e., the standard SPM
glass brain with significant effects). When you click “Table” (SPM main menu) you will get a table with all relevant values
(MNI coordinates, p-values, cluster size etc). Below the table you will find additional information, such as “Expected
Number of Voxels per Cluster”. Remember this number (this is your empirically determined extent threshold). Re-run SPM
- Results etc. and specify this number when asked for the “Extent Threshold”. There is also a hidden option in “VBM8 2>
Data presentation = Threshold and transform spmT-maps” to define the extent threshold in terms of a p-value or to use
the “Expected Number of Voxels per Cluster”.
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Special Cases

VBMS8 for longitudinal data

BACKGROUND

The majority of VBM studies are based on cross-sectional data, where one image is acquired for each
subject. However, in order to track e.g. learning effects over time longitudinal designs are necessary,
where additional time-points are acquired for each subject. The analysis of these longitudinal data
requires a customized processing, that considers the characteristics of intra-subject analysis. While for
cross-sectional data images can be processed independently for each subject longitudinal data has to
be registered to the baseline image (or mean image) for each subject. Furthermore, spatial
normalization is estimated for the baseline image only and applied to all images (Figure 4). Additional
attention is then needed for the setup of the statistical model. The following section will therefore
describe data preprocessing and model setup for longitudinal data.

Segmentation
Dartel Normalization

iy yi
Dartel
Deformations
mean mean
iy iy ri, mri, p1mri,
iy i, ri, mri, p1mri,
iy i ris mri, p1mri,
Realignment1 Realignment2 Bias correction Segmentation  Realignment3 Apply

Deformations

Fig 4.: Flow diagram for processing longitudinal data with VBMS8. This figure demonstrates
the steps for processing longitudinal data. After an initial realignment, the mean of the
realigned images is calculated (mean) and used as reference image in a subsequent
realignment. The realigned images (riy) are then corrected for signal inhomogeneities with
regard to the reference mean image. Spatial normalization parameters are estimated in
the next step using the segmentations of the mean image. These normalization parameters
are applied to the segmentations of the bias-corrected images (p1mriy). The resulting
normalized segmentations (wp1mriy) are finally again realigned.
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Preprocessing of longitudinal data - overview

The VBMS8 Toolbox supplies a batch for longitudinal study design. Here, for each subject the
respective images need to be selected. Intra-subject realignment, bias correction, segmentation, and
normalization are calculated automatically. Preprocessed images are written as wplmr* and wp2mr*
for grey and white matter respectively. To define the segmentation and normalization parameters,
the defaults in cg_vbm8_defaults.m are used.

CHANGE SETTINGS FOR PREPROCESSING

Change your working directory to “/toolbox/vbm8” in your SPM directory:

- select “Utilities = cd” in the SPM menu and change to the respective folder.

Then type “open cg_vbm8_defaults.m” in your matlab command window. The file will open in the
editor. If you are unsure how to change the values, open the module “estimate and write” in the
batch editor for reference.

The most interesting parameters to change here may be:
*  DARTEL or spm8 default normalization:
Line 65 - set to “0” for spm8 default normalization

* The Tissue Probability Maps:
Line 16 - replace “{fullfile(spm('dir'),'toolbox’,'Seg','TPM.nii')}” with the path to your Maps.

It is always a great idea to memorize or record the changes and change all values back to default after
the Analysis.

PREPROCESSING OF LONGITUDINAL DATA

VBMS8 > Process longitudinal data
Parameters:

o Data <-X = New: Subject > Subject > Longitudinal data for one subject ->Select Files
- [select raw data] = Done

- Select all volumes for each subject. As the Toolbox does not support multispectral
data yet (i.e., different imaging methods for the same brain, such as T1-, T2-,
diffusion-weighted or CT images), it is recommended to choose a T1l-weighted
image.

- Select “New: Subject” to add data for a new subject
The data for each subject should be listed as one “subject” in the Batch Editor, i.e.
there are as many subjects listed as included in the analysis.
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- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]

For the naming conventions of all written files see p.29 “Naming convention of output files”. The final
GM segments are wplmr*, the final WM segments are named wp2mr*.

Statistical analysis of longitudinal data - overview

The main interest in longitudinal studies is the common change of tissue volume over time in a group
of subjects or the difference in these changes between two or more groups. The setup of the
statistical model needed to assess these questions will be described on two examples. First, the case
of only one group of 4 subjects with 2 time points each (e.g. normal aging) is presented.
Subsequently, the case of two groups of subjects with 4 time points per subject will be described.
These examples should cover most analyses — the number of time points / groups just have to be

adapted.

STATISTICAL ANALYSIS OF LONGITUDINAL DATA IN ONE GROUP

SPM menu = Specify 2"-level

Parameters:

o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design = “Flexible Factorial”

=  Factors =2 “New: Factor; New: Factor”
Factor

Name -2 [specify text (e.g., “subject”)]
Independence > Yes

Variance = Equal or Unequal

Grand mean scaling 2 No

ANCOVA - No

Factor

Name -2 [specify text (e.g., “time”)]
Independence = No

Variance = Equal or Unequal
Grand mean scaling 2 No

ANCOVA - No

= Specify Subjects or all Scans & Factors = “Subjects” > “New: Subject; New:
Subject; New: Subject; New: Subject;”
Subject

Scans - [select files (the smoothed GM volumes of the first Subject)]
Conditions = “1 2” [for two time points]

Subject

Scans - [select files (the smoothed GM volumes of the second Subject)]
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- Conditions = “1 2” [for two time points]

Subject

- Scans =2 [select files (the smoothed GM volumes of the third Subject)]

- Conditions = “1 2” [for two time points]

Subject

- Scans 2 [select files (the smoothed GM volumes of the fourth Subject)]
- Conditions = “1 2” [for two time points]

» Main effects & Interaction 2 “New: Main effect”
Main effect
- Factor number -2 2
Main effect
- Factor number 2> 1

o Covariates (see “basic VBM analysis (detailed description)”)

o Masking
» Threshold Masking = Absolute = [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]

STATISTICAL ANALYSIS OF LONGITUDINAL DATA IN TWO GROUPS

SPM menu = Specify 2"-level
Parameters:

o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design = “Flexible Factorial”

=  Factors =2 “New: Factor; New: Factor; New: Factor”
Factor
- Name -2 [specify text (e.g., "subject”)]
- Independence = Yes
- Variance = Equal
- Grand mean scaling 2 No
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- ANCOVA - No

Factor

- Name -2 [specify text (e.g., “group”)]
- Independence = Yes

- Variance = Unequal

- Grand mean scaling 2 No

- ANCOVA - No

Factor

- Name -2 [specify text (e.g., “time”)]
- Independence 2 No

- Variance = Equal

- Grand mean scaling 2 No

- ANCOVA - No

Specify Subjects or all Scans & Factors > “Subjects” > “New: Subject; New:
Subject; New: Subject; New: Subject;”

Subject
- Scans 2 [select files (the smoothed GM volumes of the 1st Subject of first

group)]
- Conditions 2> “[1111;1234]) “[first group with four time points]

Do not forget the additional single quote!

Subject
- Scans > [select files (the smoothed GM volumes of the 2nd Subject of first
group)]
- Conditions 2> “[1111;1234) “[first group with four time points]
Subject
- Scans > [select files (the smoothed GM volumes of the 3rd Subject of first
group)]
- Conditions 2> “[1111;1234) “[first group with four time points]
Subject
- Scans -2 [select files (the smoothed GM volumes of the 4th Subject of second
group)]
- Conditions 2 “[2222;1234]) “[second group with four time points]
Subject
- Scans -2 [select files (the smoothed GM volumes of the 1st Subject of second
group)]
- Conditions =2 “[2222;1234]) “[second group with four time points]
Subject
- Scans > [select files (the smoothed GM volumes of the 2nd Subject of second
group)]
- Conditions =2 “[2222;1234]) “[second group with four time points]
Subject
- Scans > [select files (the smoothed GM volumes of the 3rd Subject of second
group)]

- Conditions 2 “[2222;1234]) ” [second group with four time points]
Subject
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- Scans > [select files (the smoothed GM volumes of the 4th Subject of second

group)]
- Conditions 2 “[2222;1234]) ” [second group with four time points]

» Main effects & Interaction 2 “New: Interaction; New: Main effect”
Interaction
- Factor numbers = 2 3 [Interaction between group and time]
Main effect
- Factor number 2 1

o Covariates (see “basic VBM analysis (detailed description)”)

o Masking
» Threshold Masking = Absolute > [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]
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Altered Workflows for VBM-analyses

Background
For most analyses the VBM Toolbox will supply all tools needed. That is, as the new segmentation

algorithm is not dependent on Tissue Probability Maps (TPMs) anymore and as predefined DARTEL-
templates for healthy adults exist, most questions can be assessed using the toolbox settings.
However, for some special cases such as analyses in children or special patient populations, the
toolbox settings might not be optimal. For these cases the VBM8 Toolbox provides an integration into
the SPM8 environment that can be used to optimize the preprocessing. In the following, we will
present strategies how to deal with these special cases.

Standard VBM preprocessing: Input, Output and where to modify
The first module of the VBMS8 Toolbox (“Estimate and Write”) processes all preprocessing steps

except for the smoothing. Basically, it takes structural volumes and TPMs as input. It will then
segment the data, apply a registration to MNI Space (either rigid or affine) and subsequently a non-
linear deformation. The non-linear deformation parameters can be calculated via the low dimensional
SPM default approach or the high dimensional DARTEL algorithm and the predefined templates.
Figure 5 depicts this preprocessing workflow and highlights possibilities where to modify.

VBMS8 —Toolbox: “Estimate and write”

SPM default VBMS8
TPMs DARTEL templates
}* |
Segmentation DARTEL
Native — normalization =  normalized
1 7 and s (VBM8 templates) (modulated)
Volumes . - Grey Matter
affine OR rigid ‘ SPM default — segments
registration normalization
Affine OR rigid
= registered
segments

Fig. 5: Flow-chart of the preprocessing steps within the module “Estimate and Write”.
Marked in red are those steps, where the preprocessing can be customized. Per
default, the built-in DARTEL normalization works with the VBM8 DARTEL templates of
550 healthy adult control subjects. Affine registered tissue segments can be used to
create customized DARTEL-templates, which can then be used to replace the default
DARTEL template.
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Adapting the workflows

Customized Tissue Probability Maps - overview

For data on children it will be a good idea to create customized TPMs, which reflect age and gender of
the population. The TOMS8 Toolbox (available via: https://irc.cchmc.org/software/tom.php) provides
the means to customize these TPMs. To learn more about the TOM toolbox, see also
http://dbm.neuro.uni-jena.de/software/tom/.

CUSTOMIZED TISSUE PROBABILITY MAPS

About the TOMS8 Toolbox:

-2 select Module “create new template”
-2 select “TOM.mat” (you will have to download this file together with the toolbox)
- write priors/template as single file
- for all others use default settings or modify. For “Age” either a vector or a mean age

(when using the average approach) must be specified.

Implementation into VBMS8:

Module: “Estimate and write”
—->”Estimation Options”.

- Tissue Probability Maps (= Select your customized TPMs here)

Customized DARTEL-template - overview

For all cases that include at least 50-100 subjects a customized DARTEL template can be created. That
is, grey matter and white matter tissue segments of all subjects are used to create a mean template of
the study sample. As the VBM8 toolbox writes all files needed to create these templates (“DARTEL
export”), this requires only two additional steps. In order to use these newly created DARTEL-
Templates with the vbm8 Toolbox, an affine registration of the DARTEL export should be used. From
these affine registered segments customized DARTEL templates can then be created and used with
the vbm8 module “Write already estimated segmentations”.
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CUSTOMIZED DARTEL-TEMPLATE

Three steps are needed to create normalized tissue segments with customized DARTEL Templates.
These steps can be batched using dependencies in the Batch Editor. The last step can be rerun using
the customized templates, if additional output files are needed. In the first step the T1 images are
segmented, and the tissue segments normalized to the Tissue Probability Maps using an affine
transformation. Start with selecting the module “Estimate and Write”.

Module: “Estimate and Write”:

-> for all options except “writing options” use settings like for a “standard” VBM analysis.
->”Writing Options”

- “Grey Matter”-> “DARTEL export” - “affine”

- “White Matter”> “DARTEL export” - “affine”

These settings will produce the volumes “rpl*-affine.nii” and “rp2*-affine.nii”, which are the grey
(rp1) and white (rp2) matter segments after affine registration. The following modules can be chosen
directly in the batch editor (SPM > Tools > DARTEL Tools > Run DARTEL (create Templates), and
SPM - Tools = VBMS8 > VBMS8: Write already estimated segmentations). It makes sense to add and
specify these modules together with the “Estimate and Write” module within the Batch Editor and to
set dependencies.

Module “Run DARTEL (create Templates)”

- Images -2 select two times “new: Images”
- Images: 2 select the “rp1*-affine.nii” files or create a dependency.
- Images: 2 select the “rp2*-affine.nii” files or create a dependency.

-> all other options: use defaults or modify

The thus created customized DARTEL Templates are now used in the vbm8 Toolbox:

Module “Write already estimated segmentations”
Parameters:
o Volumes <-X > Select the original T1 images like in the first module “Estimate and

Write”.
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o Extended Options = “High-dimensional:DARTEL” (default) = Select DARTEL Template

- if you use dependencies in the Batch Editor create a dependency on the first
Template in the batch editor. Templates 2-6 will be used automatically.

- If you have already created your DARTEL Templates, chose the fist Template
(named “Template_1" per default). Attention: If you want to rename your
template, you may either add a prefix to the default name, or make sure that
the template number is embedded in the name between two underscores
(e.g. “abc_1_xyz").

- For all other options use the same settings as in the first module, or modify.

o Writing Options = select the output files just like in any standard VBM analysis:
- For GM, WM, and CSF image volumes see page 14: “Additional Information
on native, normalized and modulated normalized volumes”.

- A bias corrected image volume, in which MRI inhomogeneities and noise are
removed, can be written in normalized or native space.

- A partial volume effect (PVE) label image volume can also be written in
normalized or native space or as a DARTEL export file.

- The Jacobian determinant for each voxel can be written in normalized space.

- Finally, deformation fields can be written. This option is useful to re-apply
normalization parameters to other images or particular regions of interest.

- File = Save Batch

- File & Run Batch

How to proceed:

All steps described above are just an adaption of the VBMS8 Toolbox module “Estimate and Write”. A
subsequent smoothing is necessary before statistics can be calculated. As always it is a good idea to
save the applied modules and to perform quality control. Here, the modules “Display one slice for all
images” and “Check sample homogeneity using covariance” from the VBMS8 Toolbox will be helpful.
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Additional information on native, normalized and modulated volumes

When preprocessing the images (see “First Module: Estimate and write”, on pages 5-6), the decision
about the normalization parameters will determine the interpretation of the analysis outcomes:

“Native space” produces tissue class images in spatial correspondence to the original data. Although
this could be useful for estimating global tissue volumes (e.g., GM+WM+CSF=TBV) it is not suitable to
conduct VBM analyses due to the missing voxel-wise correspondence across brains). Of note, if one is
interested in these global tissue volumes in native space (“raw values”), it won’t be necessary to
actually output the tissue class images in native space. The “Estimate and write”-function
automatically generates a text file for each subject (*_seg8.txt), which contains the raw values for
GM, WM, and CSF. The subject-specific values can be combined (i.e., integrated into a single text file)
by using the function “Calculate raw volumes for GM/WM/CSF”: VBM8 —> Tools = Calculate raw
volumes for GM/WM/CSF

“Normalized” produces tissue class images in spatial correspondence to the template. This is useful
for VBM analyses (e.g., “concentration” of gray matter; Good et al. 2001; Neuroimage).

“Modulated normalized” gives two different options:

. Affine+non-linear produces tissue class images in alignment with the template, but multiplies
(“modulates”) the voxel values by the Jacobian determinant (i.e., linear and non-linear
components) derived from the spatial normalization. This is useful for VBM analyses and allows
comparing the absolute amount of tissue (e.g., “volume” of gray matter; Good et al. 2001;
Neuroimage).

. Non-linear only produces tissue class images in alignment with the template, but multiplies the
voxel values by the non-linear components only. This is useful for VBM analyses and allows
comparing the absolute amount of tissue corrected for individual brain sizes. Of note, this option
is similar to using “Affine+non-linear” (see above) in combination with “global normalization”
(when later building the statistical model using the traditional PET designs). That is, when
building the statistics, one would specify “Global normalization” - “Overall grand mean scaling
— No” - “Normalization — Proportional”. It is also similar to using “Affine+non-linear” (see
above) and including the numeric brain volume (as given in the *_seg8.txt file for each subject)
as covariate (when later building the statistical model). Although all 3 approaches allow
comparing tissue volumes while correcting for individual brain size, it is recommended to use
the option “non-linear only” as it applies the correction directly to the data, rather than to the
statistical model.

For further explanation see also:
http://dbm.neuro.uni-jena.de/vbm/segmentation/modulation
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Naming convention of output files

segmented images:
m/[0]w[r]p[0123]*

m - modulated
mO - modulated non-linear only
w - warped

r - dartel warped
p - segmented

0 - PVE label

1 -GM

2 -WM

3 - CSF

_affine - affine registered only

bias corrected images:

m
W
r

wm[r]*

- bias corrected
- dartel warped

estimated raw volumes:

pxxx_seg.txt

For longitudinal data (default settings):

segmented images: bias corrected images:
wp[12]mr* mr*

w - warped m - bias corrected
p - segmented r - realigned

1 -GM

2 - WM

m - bias corrected estimated raw volumes:
r - realigned pmrxxx_seq.txt

mean images  (useful

for

overlaying results):

wmrmean*

w - warped

m - bias corrected
r - realigned

mean -mean

estimated raw volumes (mean):

pmeanxxx_seg.txt
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Technical information

This toolbox is an extension of the “New Segment Toolbox” in SPMS8, but uses a completely different
segmentation approach.’

1. The segmentation approach is based on an adaptive Maximum A Posterior (MAP) technique
without the need for a priori information about tissue probabilities. That is, the Tissue
Probability Maps are not used constantly in the sense of the classical unified segmentation
approach, but just for spatial normalization®. The following MAP estimation is adaptive in the
sense that local variations of the parameters (i.e., means and variance) are modelled as slowly
varying spatial functions (Rajapakse et al. 1997). This not only accounts for intensity
inhomogeneities but also for other local variations of intensity.

2. Additionally, the segmentation approach uses a Partial Volume Estimation (PVE) with a
simplified mixed model of at most two tissue types (Tohka et al. 2004). We start with an initial
segmentation into three pure classes: gray matter (GM), white matter (WM), and
cerebrospinal fluid (CSF) based on the above described MAP estimation. The initial
segmentation is followed by a PVE of two additional mixed classes: GM-WM and GM-CSF. This
results in an estimation of the amount (or fraction) of each pure tissue type present in every
voxel (as single voxels — given by their size — probably contain more than one tissue type) and
thus provides a more accurate segmentation.

3. Furthermore, we apply two denoising methods. The first method is a spatially adaptive non-
local means (SANLM) denoising filter (Manjon et al. 2010). This filter will remove noise while
preserving edges and is implemented as preprocessing step. The second method is a classical
Markov Random Field (MRF) approach, which incorporates spatial prior information of
adjacent voxels into the segmentation estimation (Rajapakse et al. 1997).

4. Another important extension to the SPM8 segmentation is the integration of the Dartel
normalisation (Ashburner 2007) into the toolbox. If high-dimensional spatial normalisation is
chosen, an already existing Dartel template in MNI space will be used. This template was
derived from 550 healthy control subjects of the IXl-database (http://www.brain-
development.org) and is provided in MNI space4 for six different iteration steps of Dartel
normalisation. Thus, for the majority of studies the creation of sample-specific Dartel
templates is not necessary anymore”.

* The classic SPM8 segmentation is still used in addition, but only to initially remove non-brain tissue from the image.
4Thus, no additional MNI normalization is necessary.

> For studies investigating data of children | still recommend creating a customized Dartel template. Of note, for this
option a representative sample with a sufficient number of subjects is required (n>50-100). Alternatively, if a sufficient
sample size cannot be achieved, the low-dimensional SPM8 normalization approach combined with customized Tissue
Probability Maps (e.g. from the TOMS toolbox) can be selected.
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